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Introduction

The Conference was organised by BOF Map Group Chairman, Colin Spears (HOC) with
assistance from Rod Postlethwaite (WRE). Thanks go to Major Alan Farrington (BAOC) for
providing the accommodation at Longmoor Army Training Camp.

This Conference was the first to be held in the South of England for some considerable time
and attracted a number of relatively new mappers with attendees being encouraged to ask
questions and share views.

The aims of the Conference were to help mappers to be able to generalise their surveys and
eliminate small unnecessary detail to make more useful maps for orienteers; to demonstrate
the usage of small hand-held GPS units as an aid to fieldwork; to demonstrate the features of
OCAD.

Mapping Exercise at Pump Wood

Pump Wood is a small section of typical Hampshire/ Surrey heath woodland which at one time
appeared on the Longmoor map before the construction of the A3 dual carriageway isolated it
from the main area. It was considered to be ideal for the exercise because it was relatively
simple – the kind of area the average mapper would be likely to encounter during a mapping
project.

The section of wood was a typical pine plantation but differed slightly because of the tussocky,
marshy ground that it was planted on. The tree growth varied from open runnable wood to
areas of slow run where the trees had not developed as quickly because of the boggy nature
of the ground. This also caused odd areas where the trees were so stunted that they created
sections of ‘Rough Open with Scattered Trees’. Because of the vague, transitory nature of the
area it was decided that the Distinct Vegetation Boundary was not appropriate because it
would create the impression that the orienteer would encounter a definite feature on the
ground rather than something ill defined. Use of the Rough Open with Scattered Trees symbol
was also discouraged in this instance because the areas were so small (ISOM 2000 states
that areas less than 16 sq. mm on the map are to be shown as Rough Open Land). The
reasoning behind this decision is that the symbol does not appear clear to an orienteer running
at speed whilst the Rough Open symbol does.

Another feature of the area was the marshy ground, which made progress through the terrain
rather slow. The tussocks were obvious on the ground and it was decided to utilise the
Indistinct/ Seasonal Marsh symbol as the forest wasn’t permanently wet underfoot. By using
this symbol it also highlighted the areas of slightly higher ground which were fully runnable
without any vegetation on the forest floor but did rise high enough to warrant a contour or form
line. This depiction would give the orienteer enough information about the runnability underfoot
to enable him or her to make route choice decisions.

It is important for the mapper to base decisions on what to show on the map by his/ her initial
observations of the area. These observations will be similar to what the orienteer will form
when they enter an area for the first time. It is important not to map too many features which
are trivial as this can give a false impression of the complexity of the area. Mapping is a very
time consuming exercise and it is important not to waste a lot of time mapping features which
are of little use to the navigation of the orienteer.

This exercise was a departure from previous Conferences as it allowed every mapper to
complete the survey of the area. It was not too complex or large to be completed in a short
space of time but did allow discussion on important decisions that mappers have to make.
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Practical GPS Demonstration

Bruce Bryant (OD and BOF Map Group Member) gave a practical demonstration of the
application of a hand-held GPS unit in ‘O’ mapping in conjunction with OCAD 9. With an
accuracy of about 4 metres now achievable with the EGNOS (European Geostationary
Navigation Overlay Service facility turned on, it is now very practical to use GPS as a mapping
tool. It is, however, important to note that the system is not perfect and there are many
situations where the accuracy is not achieveable. GPS can be particularly inaccurate under
tree cover and is best suited to open ground.

OCAD 9 now has the facility to import way points and tracks from Garmin GPS units directly
into the map file though a little preparation is required. Bruce demonstrated the process and a
full description can be found in Appendix A page 7.

Searching for Satellites

Map Design

A map can be considerably enhanced by putting a little thought into the layout. Brian Mee
(MDOC) has gained a lot of experience in this field by drawing a large series of permanent
course maps for GMOA (Greater Manchester Orienteering Association). These maps have an
aesthetically pleasing common layout, which was designed by Brian and Jon Sutcliffe (PFO)
and provide an excellent product for sale to the general public.

A full summary appears in Appendix B page 10.
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OCAD Hints and Tips

Rod Postlethwaite (WRE and BOF Map Group member) reviewed all the buttons on the tool
bar in OCAD 8 and covered a number of other tips for producing better maps (see Appendix C
page 12).

The OCAD web site (http://www.ocad.com) now offers a series of Flash files demonstrating
various procedures. Unfortunately, this only covers the latest version, OCAD 9, though some
of the procedures are common to both.

An OCAD Help Line is offered by Bruce Bryant through the Map Group (ocadhelp@virgin.net)

School Mapping and the BOF Specification

At the beginning of the year the Map Group produced a new specification for the production of
orienteering maps of school grounds.

In recent years there has been a significant increase in orienteering activity in schools due to
its inclusion on the National Curriculum. School grounds, however, are not like the normal
orienteering terrain of forests and moorlands and contain many features which fall outside the
confines of ISOM 2000. It became apparent to the BOF Development Officers that there were
a great number of variations in symbols used by mappers across the country and it was felt
that a co-ordinated effort was needed to address this. A new specification which followed
ISOM 2000 as closely as possible but included some of the relevant urban symbols from
ISSOM was initiated.

Pauline Olivant (NOC and Regional Development Officer) outlined the history and
development of this specification. See Appendix D page 13.

Generalisation

The IOF Map Commission has initiated a study into how best to describe generalisation in
orienteering mapping and Erik Peckett (Devon, Map Group Member and IOF Map
Commission representative) outlined the progress made so far.

Mapping can roughly be divided into two areas – plan production and map production. School
maps fall into the plan category because of the large scale nature of the areas. They are
typically produced at scales between 1:500 and 1:2500 which allows all the detail to be shown
in its exact position. However, once maps are produced at smaller scales (typically 1:5000
upwards) then the true position of features can no longer be maintained and minimum
distance symbols are utilised. This means that features have to be displaced and some kind of
selection process has to take place – generalisation.

A progress document can be found in Appendix E page 14.

ISSOM

The International Specification for Sprint Orienteering Maps (ISSOM) has recently been
revised (operative from January 2007) and there was a discussion on the subject. This
specification has been developed to encompass the more urban environment used in Sprint
Orienteering. This discipline developed from the Park World Tour (PWT) initiative started in the
1990s, with the idea of bringing orienteering to the attention of the general public. A series of
very short, fast races were held throughout the world in public parks and old town centres with
prize money being given to the winners. Eventually this discipline was adopted by the IOF and
a new specification was developed.
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This discipline is now appearing more often in Britain and maps are starting to be made using
the specification. It is, however, very different to ISOM 2000 in many aspects and maps drawn
with this specification should only be used for Sprint competitions. There is a danger that a
hybrid will start to appear as town parks are mapped using a combination of ISOM 2000 and
ISSOM – this should not happen. The Map Group is, therefore, recommending that the
words ‘Sprint Map’ should appear on any map drawn using ISSOM.

Insurance

Since the Conference the position of the issue of insurance for mappers has been clarified.
Mappers who earn up to £5000 gross per annum are covered within the British Orienteering
Public Liability insurance policy. Mappers earning more than this are expected to arrange their
own cover. The position of school mapping is slightly more difficult though it is thought that it is
an activity which promotes the sport and would, therefore, be automatically covered. Anyone
who earns an income from mapping should also ensure that their survey equipment,
computers, etc. are covered on their house insurance policy for business use.

The insurance is, however, dependent on the map being registered with British Orienteering
through the MR1 form. The system for registering school maps is not in place at present.

Map Copyright

There were a number of concerns on copyright matters, in particular the alteration of map files
by planners, controllers, etc. without the permission of the original mapper.

In the lecture room
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Appendix A GPS and OCAD 9

GPS and OCAD 9

How good is GPS for use with orienteering surveys?

GPS is very usable with open areas (parks, moorland).
GPS use is possible for wooded areas at the right time of year – accuracy will reduce
dependant on amount of tree cover and topography. Topography can have a significant effect
as the 3 EGNOS differential satellites are quite low in the sky to the south.
Accuracy is also dependent on the position and the number of conventional satellites at the
time.

With WAAS / EGNOS switched on and working, accuracy is typically 2 to 3m and usually
better than 5m.
Without WAAS, accuracy is 6m at best and often about 10m. This is not really good enough
for orienteering surveys.

EGNOS (European Geostationary Navigation Overlay Service) is a supplemental GPS system
with 3 satellites and ground stations. To receive an EGNOS signal on a compatible GPS
receiver you must switch on “WAAS”.
WAAS (Wide Area Augmentation System) is the US version of a similar system.
OCAD9 is only approved for Garmin GPS receivers. I don’t know if it will work with other
makes – it probably depends on the format that the receiver is setup for.

OCAD Set Up – Real World Co-ordinates

An OCAD map file must be set up for use with GPS

Options / Scales…
Co-ordinate System: Change to 'British National Grid'
Change co-ordinates to Real World Co-ordinates
Set Grid Distance to 1000m
Set Horizontal and Vertical offsets to match the centre of the mapped area. These
numbers are each 6 figure numbers (480000 and 131000 for Longmoor Camp)
Always set the last three digits of each offset to 000
Get these from an OS map or the bottom of a Multimap window
Set Angle to match the current magnetic variation
Use http://www.geomag.bgs.ac.uk/gifs/gma_calc.html to get the latest data
(-3.3 degrees for Longmoor July 2006) Map set to -3.2 degrees for 2007

'OS Landline' Tile Selector
http://www.ordnancesurvey.co.uk/oswebsite/products/landline/tileselector.html

This is a web page designed to preview OS Landline map data available to buy. It does,
however, display a low resolution bitmap that is ideal for the alignment of aerial photography
and previous maps to the OS grid (necessary to use GPS). The images also provide a good
base for major boundaries in rural areas or quite a lot of useful info in urban areas. These
images are continually updated so are very useful for features such as new road or housing.

Sample screen shots:
Use right-click Save As… to get the images.
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Windows Live Local (aerial photos)
http://local.live.com

The best source for free images in the UK. The images are sourced from Getmapping data so
are a bit out of date (typically about 2000). Zoomed in to maximum, typically 60 yards, the
resolution works out at 0.375m/pixel.
This is only slightly worse than bought images from Getmapping that are 0.25m resolution.
Some areas are available with another zoom level which is much clearer.

Use screen capture (such as print screen) to get the data and paste into a program such as
Photoshop Elements or Paint Shop Pro. Note that you need to use a program that supports
layers to allow you to align the captured screens and allow you to create a single large image.

NEXTMap

It is possible to buy terrain data as a grid of points at 5m intervals from NEXTMap. This Digital
Surface Model (DSM) data was collected by radar and the heights are claimed to be accurate
to <1m. From the data, using third party software, it is possible to generate contours at any
interval (typically 1, 2, 2.5 or 5m).

The data is quite expensive but is an alternative to the use of OS contours.

Alignment of Templates (Background maps) to Real World Grid (OS or GPS)

Adjust the background maps to align with the real world grid:
First align the OS landline tiles to the grid
Use this OS background map (set to transparent) to align the aerial photos.
If you wish to use an existing O-map as a template open it with OCAD and export as a
.jpg or .gif and adjust this in a similar way to align with the OS landline template

Adjustment of Existing Map Data

With OCAD 9 it is possible to adjust an existing map to align with the real world grid. The first
task is to save a version of the file with only the map content.
Import this into your set up base map (including the symbols and colour table from the map).
Note that if the existing map needs conversion to ISOM 2000 I would do that first.

Use the Extras… Transform Map function and then use this similarly to the template adjust
function:

1 click for move,
2 clicks for proportional scale/rotate
3 clicks for non-proportional scale /rotate
4 clicks to distort the map

Unless the old OCAD map was already accurately drawn to scale it will be impossible to align
the entire map to the real world grid!

I would suggest that you are better saving the old map as a template (or partial templates).
These can be individually adjusted and hidden as required and that you start again and draw
a new map using the existing map for reference only.

Base Map Printing with Grid for use with GPS Assisted Survey

To make it feasible to plot your location whilst mapping using GPS it is necessary to print out a
base map with an OS grid squares. Go into Options… Scales, Real World Co-ordinates and
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change the grid distance from 1000m to 100m. Now print out a base map with the grid
switched on (File… Print, Options and tick the ‘Print grid’ box. Use this grid together with a
100m scale (attached to your compass).

Note that your map now has OS North not Magnetic North. You may also want to add MN
lines to the map before printing!

Collection of GPS data – WAAS / EGNOS, Waypoints, Tracks, plotting current location

Make sure WAAS is switched on in your GPS setup menu – by default it is off.
You only need to do this once – the WAAS settings will be remembered unless you revert back
to default settings.
Switch on your GPS at the survey location.
Wait a couple of minutes to acquire the satellites. With the satellite advanced view page you
can see how many satellites are locked and the available accuracy.
Before you start any survey you should clear any existing waypoints and tracks. OCAD will
give an error message if you try to import these and they are outside of the map area.

Walk around and record any waypoints, a track will be recorded automatically.
You can adjust the interval that it uses to record this data – I set it for a time interval of 2 or 5
seconds. Typically a GPS unit can record 10000 track points which is quite a few hours at this
data rate.

When I record a waypoint I often make a note at the edge of the page of the waypoint number
and what the feature is.

To plot your current location change GPS pages to display the OS grid reference and then use
the map grid to plot your location.

When finished surveying, remember to switch the GPS off before driving away!

Import of GPS data, OCAD symbols for GPS

Plug the GPS into the computer (Serial or USB port depending on the type of receiver and
your computer).
Open the map file.
Switch on the GPS unit.
In OCAD 9 go to GPS and then Import from GPS…. This opens a window and you should see
the name of your GPS receiver and a status: GPS connected.
To import waypoints:
Go to GPS data and select Get Waypoints. OCAD will transfer the waypoint data and
highlights all of them (if you only want some waypoints you need to selectively highlight those
that you want to import). Click on Create. The data is imported into OCAD as a number of
objects, which are selected. Click on the required symbol and then use Change All on the
toolbar.

It is also possible to create labels when you import the waypoints - tick the Set Labels box and
then click on Create. Convert the waypoints and then select the remaining labels and assign
them to a symbol.

Use a similar method to import tracks (usually only one is available). Note it can take a minute
or two to import over a serial port. Assign the imported data to a symbol.

Don’t forget to switch off and disconnect the GPS from the USB or serial port.
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I have created a number of special symbols for use with GPS waypoints, waypoint labels and
tracks. This symbol set uses the colour table from the BOF OCAD 8 symbol set.
I intend to make this available to download from the BOF mapping pages.

You are now ready to use the data as a guide to your cartography.

Appendix B Map Design

Map Layout

Map layout is not unduly a map specific skill and can be an extension of general graphics
skills. Studying all kinds of printed material – posters, album covers or anything that has been
designed can be beneficial. Learn to appreciate what works and what doesn’t and try to
understand why.

Learning layout skills in other software such as Adobe Illustrator, Adobe (Macromedia)
Freehand, etc. can be beneficial and simpler than OCAD if you have it available (note: most of
this type of software is for professional use and can be expensive).

After completing your map you should analyse it and be self critical. Does it look right? If not
why not?
Is Layout Important?
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The most important aspect of an orienteering map is the depiction of the terrain not the
content of the surround. However, the overall appearance is important and a good layout will
inspire confidence in the map.

A competitive orienteer should not be distracted from his/ her course by a poor layout with
over sized type in peculiar fonts. The presentation is also important to the general public,
particularly on Permanent Course maps. A good layout indicates that time and effort has been
spent on the map. It is also a matter of personal pride in one’s work.

Just A Pretty Picture?

A well designed map is not just a pretty picture but an efficient tool for orienteers.

White Space

White space is a key element in graphic design and, therefore, map making. Too much content
and not enough space makes it difficult to read. Not all of the paper needs to be filled. A good
example of this can be seen in newspapers. Try reading an old newspaper from the early 20th

century (can be found in your local reference library) where all the content was published
without white space and then compare it to a modern newspaper where the content is broken
into paragraphs and interspersed with illustrations. These very principles can be applied to
mapping.

White space should be around every element on the map but you should also guard against
having too much which can make the mapped area seem a little lost.

Legend Alignment

The mapper should try to align the legend text with the adjacent border, i.e. if the legend falls
on the left hand side of the map then the text should be left justified with the symbols down the
left hand edge of the map. If it is on the right hand side of the map then the symbols should
appear to the right of the text and the text should be right justified. This can be done from the
symbol editing facility in OCAD.

Credits Text

The Credits Text is not of major importance to the map user and should be kept as small as
possible (typically 6pt text and 120% line spacing.

Other Text Items

Other text items (i.e. Scale, Contour Interval and Magnetic North) are more efficient to read
when grouped together. They are important elements of the map and should be in a larger font
size than the legend and credits but not as large as the map title.

Scale Bars and North Arrows

These should not be too large as to be intrusive in the overall scheme of the map

Title Fonts

These should be kept as plain as possible in mixed case and not too large.

Colour Scheme

A pleasing map design can be created by keeping colours co-ordinated over the whole map.

Even a school grounds map can take 8 hours or more of surveying and drawing - surely it's
worth an extra half hour to produce a good layout?
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Appendix C OCAD Features and Tips

OCAD Features & Tips

These tips apply to OCAD 8 and may differ slightly when using OCAD 9.

• Bézier curves: obtained using the Curve Mode drawing tool. The last two points are always
available for better adjustment to the target curve. This may reduce overall ‘tuning’ of a line
after tracing.

• Number of OCAD objects in map: Help > Map Information.

• Parallel tool: e.g. ditch along curving hedge. Create ditch by following along hedge line
using the ctrl key. Click Parallel tool and drag ditch away from hedge. Ditch will be adjusted
to remain parallel to hedge. This also works with the circular, ellipse and rectangular
drawing tools in both line and area modes.

• Measure: To determine the length of a line or size of an area > Select line or area and click
on Measure tool.

• To plot lines of given length & angle. Using Straight or Freehand drawing tools, double click
at start point of line. Respond to dialogue box.

• Lines/Shapes constrained to 0 or 90 degree angle. Select straight line drawing tool. Draw
with Alt key held down and the line will be constrained.

• To move a selection of objects or text (i.e. when drawing the legend) use the arrow keys.

• Reducing Length of straight or curved lines: Select line. Select Normal Point tool. Click on
line where should end. Select Remove Point tool & click on the unwanted end point and
any other points until only target end point left.

• It is good practice to keep the number of map objects down to a minimum. To do this when
continuing drawing a line hold the Shift key down on the last point of the previous line and
then commence drawing. This is very useful when switching from curved lines to straight
lines.

• To merge two objects select both lines using the Shift key and select Edit > Merge. This
can be used to merge two area fills of the same symbol though caution should be used if
one of the areas has a hole cut in it.

• When editing an existing map using a scanned template select View > Hatched Areas. This
will enable you to see the template under the colour fills.

• When using multiple templates it can be useful to have one or more of the templates as
transparent. To do this select Template > Options and tick the Transparent box.

• To draw a circle from its centre select the Circle tool and hold the Shift key down.

• By using the ‘To Graphics’ tool in the Edit menu the symbol is split into its graphic
components (i.e. a cliff symbol is split into the top line and the tags). This enables the tags
to be spaced better in tightly curved cliffs. It is recommended to use only the Edit Object
and Rotate Object tools when using this facility to maintain the correct length of the tags.

• To obtain better distinct path junctions use the Dash Point tool at the ends of the feature.
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Replacing the Symbol Set of an existing map with an updated Symbol Set (Erik Peckett)

• Open a blank map containing the new Symbol set. Import the existing map into theblank
map with zero offset. Those old symbols not matching in symbol number to a new symbol
will appear at the bottom of the symbol table.

• Select all the new symbols in the symbol table and do: Symbol > Hide. The objects now
visible in the map will be those corresponding to the old unmatched symbols at the bottom
of the symbol table.

• Select an object in the map. Find and select the corresponding symbol to it in theupper part
of the table. Usually the two symbol numbers before the decimal point will match. Do:
Extras > Change Symbol and the corresponding objects on the map will disappear.

Appendix D School Mapping and the BOF Specification

School Mapping and the BOF Specification

Why a BOF Specification?

School orienteering maps are not like ordinary orienteering maps as they are not (normally)
forested and contain many features which don’t readily fall into ISOM 2000. They also have to
be at very large scales (anything between 1:5000 and 1:500) to be of any use and contain
many features that have no place on ordinary ‘O’ maps.

Mappers have been making school maps for a number of years but it is only recently that
orienteering has appeared on the National Curriculum and demand for them has grown. Due
to a lack of a co-ordinated specification mappers have created all manner of symbols in
isolation and the quality of these school maps has varied greatly. The BOF Development
officers felt that there should be a standard symbol set to encourage consistency across the
country.

Key Points

The key points

• Keep schools specification as close to ISOM2000 as possible.
• Keep special symbols to a minimum but have a standardised set.
• Scales of 1:250 to 1:4000 are 200% larger than standard symbols.
• Scales of 1:4000 and above are 150% larger.

The Symbols

As school maps contain many buildings, the 55% black fill from ISSOM was considered to be
less harsh than the standard 100% black of ISOM 2000 and it allowed the positioning of
controls on buildings without making them difficult to see. The canopy symbol from ISSOM
was also adopted to cover the depiction of buildings that can be run under.

A large proportion of school maps contain paved areas but also ‘softer’ man-made areas such
as gravel and wood chippings so a 30% brown was selected. The step symbol from ISSOM
was also adopted. For the edge of paved areas 65% black was chosen so that the ends of
fences, walls, etc. that joined pavements could be distinguished and potentially used for
control sites. A selection of symbols were adopted from ISOM 2000 with the suggestion that
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they could used for a variety of unusual features found in schools and, finally, three new
symbols were devised (seats, sculptures and play apparatus).

General Advice to New Mappers

As part of the specification advice was offered to mappers on which elements should be
included in a school map, survey and drawing guidance, printing guidance and map
registration and copyright issues.

What is a School map used for?

An orienteering map has a variety of cross-curricula uses including geography, maths, PE, etc.

From the orienteering point of view the key elements are to:

• Teach a basic understanding of maps.
• Teach skills for orienteering.
• Encourage fast navigation.
• Simple competitions.

OCAD files available on the web site

To encourage mappers to use the specifications, the Map Group have made both the
specifications and OCAD symbol sets available for download on the mapping section of the
British Orienteering web site:
http://www.britishorienteering.org.uk/asp/makepage.asp?PID=MAPPING

Appendix E Map Generalisation

Simplification and Selection

ISOM 2000 2.4 contains two sentences:

‘Good orienteering terrain contains a large number and a great variety of features.
Those which are most essential for the runner in competition must be selected…..’

This is the basis of and reason for simplification.

What do you leave out?

ISOM 2000 suggests ‘-the importance of the feature from the runner’s view point and it’s
legibility on the map’.

It continues, ‘These two considerations will sometimes be incompatible, but the demand for
legibility must never be relaxed in order to present an excess of small details and
features on the map’.

We are now going to suggest a hierarchy for adding symbols to a map (examples given in

each section are not exhaustive).

Are some features more important than others?

1. Contour lines show the shape of the terrain and are the main means by which the runner
navigates through the area. They also enable to competitor to calculate the height they will
climb as opposed to the added distance of going round an obstacle.
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Contour lines are thus the most important element of the orienteering map and should be
the first element of our maps. Contours are usually at 5m vertical interval.

Knolls and contour depressions should be included if a contour line is used.

Mappers should remember the advice given in Section on linear features about the
smallest re-entrant and spur that should be drawn. A map that tries to show them will have
contours that are wobbly and illegible.

Form line features should be added later in the order if space and legibility permits.

2. The second set of features to be entered should be those that could be a danger to
competitors.

Examples:
Cliffs
Main roads, railways
Deep water – uncrossable rivers, lakes or marshes
Passable rock face might be added at this point, as they may constitute a danger if
approached from above. They also constitute a source of navigational aid.

It may well be that, for example, the contours in 1 may be modified around a cliff to
indicate the height of the cliff.

3. The third group will be those features that hinder the runner. It will be assumed that the
terrain is runnable (white) unless screens indicate otherwise.

Examples:
Vegetation: very difficult to run, impassable
Vegetation that is difficult to run
Boulder fields - stony ground
Marshes
High fences – it would be important to mark crossing points

4. Those features that may help the runner to progress through the terrain.

Examples:
Minor roads, tracks and paths
Walls and fences
And other linear features
Vegetation that is run able in one direction

5. Features that will help the competitor to locate their position.

Examples:
Building, other man made structures and distinct vegetation boundaries

6. Above ground features.

Examples:
Small knolls
Boulders
Cairns
Towers

7. Below ground features such as
Pits and shallow depressions

It may well be that in feature rich areas the mapper will not use any symbol from set 7.
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